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Overview of Super Show & Tell
With SST, you create a presentation based on the concept of a slide carousel.    Each new visual in 
the presentation is a slide.    A group of slides form the presentation or slide carousel.

Each slide has a background image or color.    A slide can be enhanced with the addition of    media 
elements, like text, graphics, images, sounds or movies.    A variety of attributes    and/or actions    can 
be assigned to each media element.



How to Register SST
Fill in and mail the registration card that came with your copy of SST to:

Ask Me Multimedia, Inc.

7100 Northland Circle, Suite 401

Minneapolis, MN    55428-1500



How to Contact the Makers of SST
The creators of Super Show & Tell can be reached by:

By

Phone (612) 531-0603    8:00am to 6:00pm central standard time.

Fax (612) 531-0645

BBS (612) 531-0702 ( 9600, 8, n, 1 )

Mail Ask Me Multimedia, Inc.

7100 Northland Circle, Suite 401

Minneapolis, MN    55428-1500



Add on Products
The Ask Me Multimedia, Inc. has carefully selected the following products as enhancements to your 
presentation system.    These products have been thoroughly tested and are guaranteed to work with 
Super Show & Tell:

1.)    PhotoMorph.................................................................... $ 79.00
Amazing special effects for your PC!    Comes complete with image editing tools, 12 
transitional effects and 17 new special effects.    Allows you to create still images and 
digital video.

2.)    Conversion Artist............................................................ $ 69.00
Convert images from just about every known graphic format to any other format    
instantly.    A "must have" tool for the casual and professional presentation maker.    
Includes an impressive set of image editing and enhancement features. 

3.)    Guide To Multimedia CD-ROM........................................ $    9.95
The one stop shop for getting started in multimedia.    Comes with a full array of royalty-
free clip media, sample applications for business, education, and home, and the book, 
"Making Great Presentations On Your PC."    

4.)    Super Show & Tell Media Library on CD-ROM............... $ 49.95
The most extensive collection of scenic photos, slide backgrounds, bullets, buttons, 
textures, music, sound effects, animation and digital video files, ever assembled for SST 
presentations.    An indispensable library for the multimedia presenter.

5.)    Multimedia In-Flight Magazine......................................    FREE
A publication for SST Frequent Flyers.    Keep up on the latest SST upgrades, MPC 
specifications, and tips and techniques on creating SST presentations.    Here from other 
passengers on how they fly the SST.

HOW TO ORDER:
Call us at (612) 531-0603; or fax us at (612) 531-0645.

Shipping Charges will be confirmed at the time of order.

Credit card, cashiers check, or wire orders only.    Sorry, no purchase orders, CODs, or company 
checks accepted.    Availability and prices subject to change.





File Menu Commands

New  
Adds a new carousel.    Names of currently loaded carousels are located in the Window Menu. 

Open
Opens an existing carousel selected from a list of .SST files.

Close
Closes the current carousel.

Save
Saves the contents of the current carousel.

Save As
Saves the contents of the current carousel under a specified name.

Save All
Saves the contents of all open carousels.    (Click on the Window Menu to see a list of all open 
carousels.)    The choices to Save or Save As... refer to only one carousel, the carousel currently 
visible on the screen.

Autosave
Toggles the Autosave feature on or off.    If the Autosave option is selected, a backup file will be 
automatically created.    The backup file will be named filename.bak, where filename is the name of 
the SST file being saved.    The backup file will be updated if there has been no activity in SST for a 
period of 5 minutes.    

For example, if the Autosave feature was toggled on while TUTOR.SST was open, after 15 minutes a 
file named TUTOR.BAK will be created, automatically saving the contents of that file.

Printer Setup
Sets printer options.

Print Handouts
Prints handouts of the screen display.

Print playlist
Prints information about the open carousel, including an illustration of each slide and the contents of 
its playlist.



Create Presentation Disk
Create Presentation Disk copies all files needed to play the the current carousel.

Options include:

Compress Presentation Files to save disk space.

Copy Windows Setup Files to create a Windows Setup disk(s) to install your carousel.

Lock Runtime Carousel to create a locked version of the current carousel.    Locked 
carousels will run, but they cannot be loaded, modified or viewed in SST's runtime editor.

Quit
Exits SST.



Edit Menu Commands
Delete
When delete is selected the Delete Verification Dialog Box will present three choices:

Delete current action (current action is identified here)

Delete current element (current element is identified here)

Delete entire slide
Select an item to delete or cancel if you choose not to delete any of the three listed items.

Duplicate
Creates an exact copy of the currently selected element.

 

Insert Slide
Inserts a new slide before the current slide.

Align Top
Positions the selected element with the top edge of its bounding box at the top edge of the screen.    
When multiple elements are selected, all are aligned to the element nearest the top edge.

Align Left
Positions the selected element    with the left edge of its bounding box at the left edge of the screen.    
When multiple elements are selected, all are aligned to the element nearest the left edge.

Align Bottom
Positions the selected element with the bottom edge of its bounding box at the bottom edge of the 
screen. When multiple elements are selected, all are aligned to the element nearest the bottom edge.

Align Right
Positions the selected element with the right edge of its bounding box at the right edge of the screen.  
When multiple elements are selected, all are aligned to the element nearest the right edge.

Center Vertically
Centers the selected element on the screen from left to right.    If multiple elements are selected, 
elements will be aligned with the center element.

Center Horizontally
Centers the selected element on the screen from top to bottom.    If multiple elements are selected, 
elements will be aligned with the center element.



Carousel Menu Commands
Play Options
Sets play options for the entire carousel.    

Jump to Slide
Jumps directly to indicated slide and makes it the current slide.    Presents a thumbnail sketch of each 
slide as it is highlighted for clarification (to ensure that the intended slide is being selected).



View Menu Commands
Toolbar Buttons 

Toggles the display or removal from the screen of the delete, duplicate and alignment icons.

Bring To Top, Bring Forward, Push Behind and Push To Bottom
Media elements are layered on a slide as they are added, with those elements on the top covering 
elements in lower "layers".    The element list reflects the order of the elements on the slide.    To 
reorder these elements, highlight the element to be moved and select one of the following:

Bring To Top moves the selected media element to the top layer or slide foreground.

Bring Forward brings the element forward one layer or one position in the slide.

Push Behind moves the element back one layer or one position in the slide.

Push To Bottom moves the element behind all other elements.



Run Menu Commands
Run
Plays entire carousel.

Full Screen 
When selected, plays slide full screen not the preview window only.

Play Single Slide
Sets option to play only the current slide and not the following slides.



Window Menu Commands
Close All
Closes all open SST Carousels

Names of Open Carousels
A check ( ) by a carousel name indicates the carousel is currently loaded.



Play Options
Pause Presentation Key
Sets a default key value used to initiate and end a pause, allowing the screen to go black while the 
pause is in effect.

Exit Presentation Key
Sets a default key value used to exit from a carousel presentation.

Jump to Slide Dialog
Sets a default key value used to bring up a list of slides.

Mouse Button Actions
Defines specific actions for each of 3 mouse buttons.

Carousel Presentation Mode
Sets a presentation mode to continually repeat or play only once.

Unload Slides When Played
Removes slide information from memory after it has been played.    This option is helpful with large 
presentations.

Disable Auto-Blacking (clearing screen when palettes differ)
By default, SST will automatically clear to black before showing a new image with a different palette.   
This prevents the flash of color seen during these transitions, when images with different palettes are 
being shown.    Since there are times when Auto-Blacking is not appropriate, this option can be 
toggled on or off.



Help Menu Commands

Index
Starts this on-line help system.

About
Presents current version information about SST.
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Carousel
A carousel is the basic structure on which SST presentations are built.    Carousels are made up of 
slides and can contain an entire presentation or be linked together to form a larger presentation. 



Slide
A slide is a segment of an SST presentation or carousel.    Each slide can be thought of as a mini-
movie.    A slide can have its own attributes and it may contain additional elements.



Element
An element is a media component which can be added to a slide.    It can be text, a graphic, an 
image, a sound or a movie.    Elements can have a variety of attributes and can take on actions.



Attribute
An attribute is a quality that a slide or a slide element can have. Possible attributes vary according to 
the type of media.    For example, font style is a text attribute, shape is a draw attribute. 



Action
An action is used to define a change in an element while a slide is being shown.    Actions vary 
according to the type of media.    A move is an example of an image action, whereas play is an 
example of a sound action.



Asynchronous
Actions not occurring at the same time.



Synchronous
Synchronous means to occur concurrently. Synchronous actions are played together.



Action Playlist
The action playlist is a list of all actions defined for the current slide.



Alignment Icons
The alignment icons are used to position media elements on the screen.



Edit Icons
The edit icons are used to delete or duplicate elements .



Element List
The element list is a list of all media elements on the current slide.    



Play Controls
The play controls allow you to play back or view the actions on the current slide as well as advance, 
reverse one slide at a time or jump to the beginning or end of a carousel.



Media Editor
The media editor is used to present attribute options for the selected media element.    The editor allows you to 
make selections, such as filename, shape or font style, which are used to define each element.    



Tile
The tile effect is used to fill an entire area with multiple copies of an image.



Use Image's Palette
The Use Image's Palette Option instructs SST to use the palette of the current image for the current 
slide.



Preview Window
The Preview Window is a work window in SST where the slides are created and modified in a quarter 
screen area.



Convert
The Convert button is used to convert images to the BMP file format.    The BMP file format can be 
displayed more quickly than other file formats.





Relating to carousels
To create a new carousel 

 From the File Menu, choose New.

To open a carousel

 From the File Menu, choose Open.

To modify current carousel default settings
1. From the Carousel Menu, choose Play Options

Click on To

Pause Presentation Key define the key selection to pause.

Exit Presentation Key define the key selection to stop the presentation.

Mouse Button Actions define actions for each mouse button.

Carousel Presentation Mode select a new presentation mode.

Jump to Slide Dialog define the key to activate the Jump to Slide Dialog Box.

Unload Slides when Played unload slides after being presented, thus freeing memory.

Disable Auto-Blacking disable clearing to black before showing a new image with a 
different palette.    By default, SST automatically clears the 
screen to black before showing the next image.    This 
prevents the flash of color otherwise seen during the 
transition.

To save changes on a carousel

 From the File Menu, choose Save.

To save a new carousel or to save a carousel with a new name

 From the File Menu, choose Save As...

To view a larger number of slides on the current carousel

 Click the Slide Sorter icon .



Relating to slides

To add a new slide

 Click on the Next Slide icon  to advance to the next slide.
OR

 From the Edit Menu, Click on Insert Slide to insert a slide.    The slide will be placed in front of the current 
slide.
To change current 

 Double click on the thumbnail sketch of the slide to be selected.    It will be placed in the slide preview 
window.
To change slide attributes

 Click on the background area of the slide to bring up the slide Media Editor then click on the Attributes 
dialog box.
To move a slide to a new position

 Position the mouse cursor on the slide thumbnail, then drag and drop it on the new position.



Relating to elements
To add a new element

 Click on the Media Selection Icon then select one of the 5 media types.

To modify an element
1. In the Media Editor, click on attributes.

2. Click on the Attribute to be modified.    Attributes vary according to the type of media.

3. Make the appropriate selection on the edit box.

To position an element on the slide

 Drag the element to the new position and drop it.

OR

1.    In the Media Editor, click on Attributes.

2.    Click on Location.    

3. Manipulate the arrow keys in the edit box to position the element.

To select an element

 Click on the element.

OR

1. Click on the element list.

2. Click on the description of the element.

In either case, a bounding box will appear around the element to identify it as the selected or current 
element.

To select multiple elements
1. Select one of the elements.

2. Hold the SHIFT key down and click on other elements.

3. Release the SHIFT key when all elements have been selected.

To view the element list

 Click on the Element List dialog box.



Relating to actions
To add an action

1. When the element is highlighted, click on the Action Icon  to bring up a list of actions.
2. Select an action.

OR
1. Highlight an element, then right click on the element to bring up a list of actions.
2. Select an action.

To change time interval
1. Select the action to be modified in the Action Playlist.

2. Position the mouse cursor over the time display until the cursor changes shape.

3. Click the mouse to position the cursor.

4. Edit the time display.

To reorder actions
1. Click on the Action Playlist dialog box to see the complete list.

2. Select the action to be moved.

3. Drag and drop the action to the new location.

To synchronize actions
1. Click on the Action Playlist dialog box to see the complete list.

2. Select the first action which is to be synchronized.

3. Toggle the Synchronize Icon to the synchronize position .
4. Toggle on the Synchronize Icon of each subsequent action which is to be synchronized with the first 
action.

To view the Action Playlist

 Click on the expand icon in the Action Playlist dialog box.





Overview of Screen
If you want to know more about Delete, Duplicate, or Alignment, the Media Tools or the Slide Element 
List, click on the image below.

 

If you want to know more about the Media Editors or    the Preview Window, click on the appropriate 
image below.

        

 

If you want to know more about the Action Playlist, Control Panel or Add Action, click on the image below.

 

If you want to know more about the Slide Sorter, Thumbnails or the Status Bar, click on the image below.

 



Edit Tools, Alignment Tools, Slide Elements & Media Selection

Delete     Use Delete to remove the currently selected element, element action or slide.

Duplicate     Use Duplicate to create an exact copy of the currently selected element.

Alignment Tools     The Alignment Tools are used to align elements on the 
current slide.

Media Selection     The Media Selection Icon is used to add a new element and select a media 
type for the element.

Slide Element List     The Slide Element List contains a list 
of elements for the current slide.



Media Editor
The Media Editor is used to assign attributes to the current slide or media element .    The editor will 
be presented in one of 6 styles: slide, text, draw, image, sound or movie.    The style changes 
automatically according to the type of element selected.

The current style can be identified by a media type icon in the top right corner of the editor.

Slide Editor  Text Media 

 

Draw Media  Image Media 

 

Sound Media  Movie Media Editor 

 

Click on the attributes dialog box  to see a list of attributes available for the 
current media type.    When an attribute    is selected, the editing box will change to present choices for 
that attribute.    For example, if the fill color attribute is selected, the edit box will contain a color dialog 
box.



Preview Window
The current slide is presented in the slide Preview Window.    This is a work window where the slides 
are created and modified in a quarter screen area.    As new elements    are added, they appear and 
can be positioned in the window.    



Action Playlist, Action Icon and Play Controls

The Action Playlist     contains a list of actions that 
will be applied to the current slide.

The Action Icon  is used to add action to the slide or the selected element.    Click on the action icon to 
bring up a list of available actions for the slide or currently selected element.    Available actions will vary 
depending on the type of media.    The six main groups of actions are Slide Actions, Text Actions, Draw 
Actions, Image Actions, Sound Actions and Movie Actions.

The Play Controls  are used to play the actions defined 
for the current slide, to advance and reverse the carousel.



Slide Sorter, Thumbnails and Status Bar

Slide Sorter
Click on the  to flip up a new screen presenting more thumbnail sketches.    Thumbnail sketches may 
be sorted by dragging the sketch to the desired location.    To move through and reorder a large 
carousel quickly use the Autoscroll    technique .    

Thumbnail sketches
Thumbnail sketches are tiny reproductions of slides.    Their purpose is to present a cross section of the 
carousel relative to the current slide.    The first two thumbnail sketches in the band precede the current 
slide in the carousel.    The last two sketches follow it.

Current slide thumbnail     
Double click on the highlighted thumbnail to see the slide full screen and to view any actions on the slide.

Status Bar
The Status Bar is located at the bottom of the screen.    As the cursor passes over buttons on the screen, 
their function is briefly explained in the Status Bar.



Alignment Tools 
Use these features to align selected item(s) on the screen.

 The left align icon positions the selected element    with the left edge of its bounding box at the left 
edge of the screen.    When multiple elements are selected, all are aligned to the element nearest the left 
edge.

 The top align icon positions the selected element with the top edge of its bounding box at the top 
edge of the screen.    When multiple elements are selected, all are aligned to the element nearest the top 
edge.

    The right align icon positions the selected element with the right edge of its bounding box at the 
right edge of the screen.    When multiple elements are selected, all are aligned to the element nearest the
right edge.

    The bottom align icon positions the selected element with the bottom edge of its bounding box at 
the bottom edge of the screen. When multiple elements are selected, all are aligned to the element 
nearest the bottom edge.

    Centers the selected element on the screen from left to right.    If multiple elements are selected, 
elements will be aligned with the center element.

    Centers the selected element on the screen from top to bottom.    If multiple elements are selected, 
elements will be aligned with the center element.

Selection of more than one element is accomplished by holding the SHIFT key and clicking on 
additional elements.



Media Selection 
The media selection icon allows you to add a media element to a slide.    If this icon is selected, five 
choices appear:    text, image, sound, draw and movie.

Text            is used to add text onto the current slide.

Image  is used to place external images (BMP, DIB, PCX, GIF, TIF, WMF and TGA) on the 
current slide.

Sound  is used to select sound files (WAV or MIDI formats) for the current slide.

Draw       is used to draw lines, rectangles and ellipses on the current slide.

Movie  is used to select animation files (FLI, FLC) and Video for Windows files (AVI) for the 
current slide.
When a selection is made the element will be added to the slide and will appear in a bounding box on the 
slide Preview Window .
Note that the Media Editor    changes for each of the different media types.



Slide Element List 

The element list dialog box displays the currently selected element .    A slide element may be text, an 
image, a shape, sound or other media contained within a bounding box.    Click on the dialog box to 
view a list of all elements on the current slide.    Each element is defined by its media type and a brief 
description or relevant file name.        

Click on any element in the list to select it.    That element will be highlighted in the slide preview 
window and the appropriate Media Editor for that element type will be presented. 

 Also see Preview Window , Media Editor        



Action Playlist 
The current action    appears in the action playlist dialog box. Click on the expand icon to bring up a 
list of all actions assigned to a slide.    

Each line in the playlist has:    

the synchronize icon depicting whether the action is played asynchronously     or 
synchronously    

 with other actions, 
a text description of the action and 
a time interval over which the action will occur.

The action playlist is automatically generated as new actions are added to the slide.    The playlist can
also be edited to rearrange, synchronize or change the timing of actions.    These values can be 
modified directly on the playlist. To synchronize the action, click on the play together icon to toggle it 
on or off.    Default values for the time functions are used.    To change the time interval the action must
be the current action.    If it is not highlighted, double click on the line to make it the current action.    
Position the mouse cursor over the time listed. When the cursor changes, click the mouse and edit 
the amount.    Current actions can be reordered in the playlist by dragging and dropping the 
highlighted action to a new position.

On the right edge of the playlist are arrows which allow you to move through the playlist, as follows:     
 move to first action
 move back 5 actions
 expand or collapse action playlist
 move forward 5 actions
 move to last action



Play Controls
 loads the first slide in the carousel.

 loads the previous slide.

 steps back one action only.

 moves quickly back through the actions to the first action. 

 stops the playback of actions.

 plays all the actions following the selected action on the current slide.

 steps forward one action only.
 loads the next slide.

 loads the last slide in the carousel.



Text Actions
Text Actions are actions which can be assigned to text elements.    

Use To    

Move Move a text element to a new position on or off the slide.

Size Change Expand or shrink the size of the text element bounding box.

Font Change Change to a different font style.

Fill Color Change Change the color of the text.

Text Alignment Change the alignment of the text in the bounding box.    Choices are 
left, right or center alignment.

Background Color Change Change the background color in the bounding box behind the text.

Background Mode Change the background mode.    Choices are transparent and 
opaque.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked. 



Draw Actions
Draw Actions are actions which can be assigned to a draw element.

Use To    

Move Move a draw element to a new position on or off the slide.

Size Change Expand or shrink the size of a shape.

Fill Color Change Change the inside or fill color of a shape to a different color.

Pen Color Change Change the draw or perimeter color of a shape to a new color.

Shape Change Change the element to a different shape.    Choices are line, 
rectangle or ellipse.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked. 



Image Actions
Image actions are the actions which can be assigned to an image element. 

Use To    

Move Move the image to a new position on or off the slide.

Size Change Expand or shrink the size of the image.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked.



Sound Actions
Sound Actions are the actions which can be assigned to a sound element.

Use To    

Play Sound Play the sound file.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked.



Text Media Editor
The text editor is used for all text elements.    Nine text attributes may be selected from the text editor. 

Use To    

Text Enter or edit the text string for the current text element. 

Font Select a font style and font attributes such as bold or italic.

Alignment Align the text string within the bounding box to the left, right 
or center of the bounding box.

Fill Color Set the color for the text itself.

Background Color Set the background fill color of the area inside the bounding box of 
the text element.    

Background Mode Set the background mode to transparent (the default) or opaque.    If 
the mode is transparent, the background color attribute has no effect.

Location Position the element on the slide using right, left, up and 
down arrows.

Size Adjust the width and height of the bounding box.    Width and 
height can also be adjusted by pulling the right-middle, lower-right, or
lower-middle pull points around the bounding box.

Hot Spot Define the area covered by this element as a hot spot to 
branch to a specific slide in this or any another carousel or to trigger 
a Play Sound or Show Movie action.



Draw Media Editor
The Draw Editor is used to modify all draw elements.    Six attributes can be selected in the Draw 
Editor.

Use To    

Shape Choose one of 3 shapes:    line, rectangle or ellipse. 

Fill Color Select a fill color to fill the inside area of a circle or rectangle.

Pen Color Select a pen color for the perimeter of the shape.

Location Position the element on the slide using right, left, up and 
down arrows.

Size Adjust the width and height of the bounding box.    Width and 
height can also be adjusted by pulling the right-middle, lower-right, or
lower-middle pull points around the bounding box.

Hot Spot Define the area covered by this element as a hot spot to 
branch to a specific slide in this or any another carousel or to trigger 
a Play Sound or Show Movie action.



Image Media Editor
The Image Editor is used to select or modify image elements.    Four attributes can be selected from 
the Image Editor.

Use To    

Image Select an image file (BMP, PCX, DIB, TIF, GIF, WMF, PCD or
TGA formats) for the image element.    If you wish to convert any of 
the last five file formats to the BMP format, click on the Convert    
button.    You may toggle on the Use Image's Palette    feature when 
you select this attribute.

Location Position the element on the slide using right, left, up and 
down arrows.

Size Adjust the width and height of the bounding box.    Width and 
height can also be adjusted by pulling the right-middle, lower-right, or
lower-middle pull points around the bounding box.

Hot Spot Define the area covered by this element as a hot spot to 
branch to a specific slide in this or any another carousel or to trigger 
a Play Sound or Show Movie action.



Sound Media Editor
The Sound Editor is used to select or test sound elements.    There are two attribute selections in the 
editor.

Use To    

Sound Select a sound file (WAV and MIDI formats) to associate with
the current sound element.

Controls Test the sound file.    Choices are play, stop and pause. 



Slide Editor
The Slide Editor is used to assign attributes to the background slide itself.    Five attributes can be 
assigned.

Use To    

 Image Select an image file (BMP, PCX, DIB, TIF, GIF, WMF, PCD or
TGA formats) for the image element.    If you wish to convert any of 
the last five file formats to the BMP format, click on the Convert    
button.    You may toggle on the Tile    effect or the Use Image's 
Palette    feature when you select this attribute.

Sound Select a sound file (WAV or MIDI formats) to associate with 
the slide.

Fill Color Assign a background color to the slide itself.

Entrance Define entrance options    for the slide.

Exit Define exit options    for the slide.



Movie Media Editor
The Movie Editor is used to select animations or Video for Windows movie elements.

Use To    

Movie Select a movie file (AVI, FLI, or FLC formats) for the movie 
element.

Controls Preview the movie file.

Location Position the element on the slide using right, left, up and 
down arrows.

Size Resize the movie element.



Movie Actions
Sound Actions are the actions which can be assigned to a sound element.

Use To    

Play Play the movie file.

Move Reposition the element as it plays.

Size Change Resize the element as it plays.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked.



Entrance Options
Use To    

Slide Entrance Transition choose the transition effect used to present the slide. (List entrance 
transition effects )

Duration set length of time for entrance transition.

Stop Previous Slide Sound turn off sound from the previous slide.

Slide Name define a name for this slide.



Exit Options
Use To    

Slide Exit Transition choose the transition effect used to remove the slide. (List exit 
transition effects )

Duration set length of time for exit transition.

Select Next Slide select the next slide if it is not the next slide in order in the 
carousel.

Stop Sound on Exit stop sound when the slide exits.

*Exit when:

        slide time elapsed exit when the time set for the slide has elapsed.

        slide audio complete exit when all audio files have finished playing.

        all actions complete exit when all actions have been completed.

*Note:
If more than one Exit condition is marked, the slide will exit only when all marked conditions    are met.

If    none of the Exit conditions are marked, your slide will not exit.    This method is typically used in 
conjunction with Hot Spots so the slide will not continue until a Hot Spot is selected.    



Autoscroll Technique
The Autoscroll technique is used to quickly move through your carousel.    To use this technique, click 
on a slide and drag it off the edge of the screen:

Towards the top to scroll to the beginning of the carousel, a row at a time.

Towards the right to advance through the carousel, one slide at a time.

Towards the left to move backward through the carousel, one slide at a time.

Towards the bottom to move to the end of the carousel, a row at a time.



Entrance Transitional Effects
The following is a list of entrance transitional effects available in SST:

Show Image shows the slide without any special effect.    This is the default entrance.

Horizontal Blinds presents the image in horizontal bands across the screen, which 
increase in size until they fill the screen.    This creates the illusion of blinds being opened.

Vertical Blinds presents image in vertical bands across the screen.

Slide from (direction) slides the image onto the screen from the specified direction.    
With a slide transition, the opposite edge of the slide appears first and gradually shifts 
into the correct position.    Slide transitions can occur from the Right, Left, Top, Bottom, 
Top Right, Top Left, Bottom Right or Bottom Left.

Reveal from (direction) reveals the slide from the specified direction.    This transition 
gives the illusion of simply uncovering the slide, instead of moving or "sliding" the slide.    
Reveal transitions can occur from the Right, Left, Top, Bottom, Top Right, Top Left, 
Bottom Right, Bottom Left, Center or Edges.

Grow from (direction) increases the size of the slide until it fills the entires screen.    The 
slide first appears in a reduced form at the location defined by the direction.    Grow 
transitions can occur from the Right, Left, Top, Bottom, Top Right, Top Left, Bottom Right, 
Bottom Left or Center.

Double Blinds combines the horizontal and vertical blind transitions for a square fill 
effect.

Open Iris fills the screen beginning from a circle in the center and developing outward.    
As the transition evolves, the circle gradually changes into the rectangular shape of the 
screen. 

Star Burst fills the screen beginning with a star shape and developing outward until the 
entire screen is filled.



Slide Actions
Slide Actions are the actions which can be assigned to the slide.

Use To    

Fill Color Change Change the fill color of the slide.

Pause Pause before executing the next action in the action list for a 
set period of time or until a specified key or mouse button is clicked.



Exit Transitional Effects
The following is a list of exit transitional effects available in SST:

Hold Image keeps the slide on screen until it is covered with the next slide in the 
carousel.    This is the default transition.

Horizontal Blinds removes the slide by covering it with black horizontal bands across 
the screen.    The bands increase in width until the entire slide is removed.    This 
transition creates the illusion of blinds closing.

Slide to (direction) slides or shifts the slide off the screen in the specified direction.    
Direction options are Right, Left, Top, Bottom, Top Right, Top Left, Bottom Right and 
Bottom Left.

Hide to (direction) hides or covers the slide with black in one of the following directions: 
Right, Left, Top, Bottom, Top Right, Top Left, Bottom Right, Bottom Left, Center or Edges.

Shrink to (direction) shrinks or scales down the slide until it disappears from the screen. 
The Shink transition can take place to the Right, Left, Top, Bottom, Top Right, Top Left, 
Bottom Right, Bottom Left or Center.

Double Blinds removes the slide by covering it with vertical and horizontal black bars 
which increase in size until the slide is completely covered.

Close Iris removes the slide in a pattern which begins at the outside edges of the screen 
and moves inward.    As the transition evolves, the slide which remains assumes a circular
shape in the center of the screen.

Star Burst removes the slide from the outside edges and moves inward.    As the 
transition evolves, the remaining slide is visible in a star shape before disappearing from 
the screen.





Quick Lesson 1 - Beginner
 Quick lesson 1 will show how easily and quickly a presentation can be built.

This lesson may be printed, if you want a print out of Quick Lesson 1, choose Print Topic from the 
File Menu.

Introduction to the Background Slide:
The Background Slide can be thought of as a backdrop for your presentation.    To add a Background 

Slide to your presentation click the  button in the Media Editor.    This will bring a 
dialog to the screen for you to select an image.    Select sst_logo.bmp for your Background Slide.

Notice that the Slide Element List has the name of the image for your Background Slide, the Preview 
Window    now contains a reduced version of the Background Slide, and that there is a small thumbnail 
sketch named Slide 1 near the bottom of the screen.    

Click the  on the Carousel Control to advance to the next slide.    Add another Background Slide image 
named argyle.bmp to your presentation.    You will see that this image is quite small and is in the center of 
the screen, to fill the screen with many of these images, select Tile from the Media Editor.    

To see the presentation you have created, perform the following steps:

Click the  on the Carousel Control to back up to the first slide in your Carousel.
From the Run Menu select Full Screen (a  will appear to the left when selected) and unselect the option 
Play Single Slide.
Double-click the Current Slide Thumbnail.

Introduction to Background Sound:
Adding sound to your presentation is also very easy.    To add sound to the presentation you created 
above perform the following steps.    

Click the  on the Carousel Control to back up to the first slide in your Carousel.
Pull down the Attribute List above the Media Editor and select Sound.    You will notice that the Media 
Editor has now changed to an editor that is applicable to sound.

Click  to bring a dialog to the screen for selecting a sound file.    Choose the file named o-
view1.wav.

You have just added sound to your presentation!    To see and hear the presentation, 
double-click the Current Slide Thumbnail.



Quick Lesson 2 - Intermediate
Quick lesson 2 will introduce actions    and the Action Playlist.

This lesson may be printed, if you want a print out of Quick Lesson 2, choose Print Topic from the 
File Menu.

Introduction to the Actions in Slides:
Create a Text Element:

Click on the Media Icon .
Click on the Text Icon  then drag and drop the Text Element near the left edge of the screen.

Edit the text:

While the Text Element has the Bounding Box around it, make sure the Attribute    is set 
to Text in the Media Editor.

Click in the large white area in the Media Editor    that contains the words Default Text. 

Change the words to: Hello, and welcome to the world of Multimedia!

Resize the Bounding Box to make complete text visible:

Click and drag the center Pull Point, on the right edge of the Bounding Box, towards the 
left edge of the screen until the ! can be seen.

Move the Bounding Box to the lower right portion of the Preview Window:

Click anywhere inside the Bounding Box and drag it towards the lower right corner of the 
Preview Window.

Change the Attribute of the Media Editor to Alignment:

Click the Down Arrow for the Attributes and select Alignment.

Change to Right Align:

Select Right in the Media Editor.

Move the Bounding Box so that the words cannot be seen on the screen but the left edge
of the Bounding Box is still visible.

Add a Move to the Text Object:

While the Bounding Box is still visible, Click the Action Icon .    A list of applicable actions 
will appear on the screen, select Move.

Click and drag the Bounding Box to the lower left corner of the screen until the ! disappears.

To see what has been created, perform the following steps:

From the Run Menu select Full Screen (a  will appear to the left when selected) 



Double-click the Current Slide Thumbnail.

If the words seem to go by too fast to read, the time for each action is easily adjusted.

Adjust the time for this action:

Click on the Expand Icon for the Action Playlist

Select the Move Text action

Click on the number 2000 and change it to 10000.    This number is in milliseconds 
(10000 = 10 seconds).

Run the presentation to see what has changed:

Double-click the Current Slide Thumbnail.

Add a circle to the screen:

Click on the Media Icon .
Click on the Draw Media Icon , drag and drop the element in the upper left corner of the Preview 
Window.
Change the Attribute of the Media Editor to Shape by clicking the attributes box.
Click on Ellipse in the Media Editor.

Add a Move to the ellipse:

While the Bounding Box is around the ellipse, click the Action Icon .    A list of applicable 
actions will appear on the screen.

Select Move.
Drag and drop the ellipse near the bottom middle portion of the Preview Window.

Add another Move to the ellipse:

While the Bounding Box is around the ellipse, click the Action Icon , a list of applicable 
actions will appear on the screen.

Select Move.
Drag and drop the ellipse near the top right portion of the Preview Window.

Run the presentation to see what has changed:

Double-click the Current Slide Thumbnail.

Notice that the Synchronize Icons (located in the Action Playlist) looks like this .    This means that 
these actions will happen one after the other.

Change the Actions to be Synchronized:

Click on the Expand Icon for the Action Playlist to expand the Action Playlist.

Click on all three of the Synchronize Icons (They will now look like this ).
Adjust the time for the Move Shape Actions to 5000 milliseconds each.    To do so, double-click on the 
action, when it is highlighted edit the time.



Congratulations!    You have successfully added action to a slide, run the presentation to see what has
changed:

Double-click the Current Slide Thumbnail.



Quick Lesson 3 - Advanced
Quick lesson 3 will introduce the more advanced features of    SST such as pause, wait for input and 
branching.

This lesson may be printed, if you want a print out of Quick Lesson 3, choose Print Topic from the 
File Menu.

In this tutorial, four slides will be created.    The first slide will be an interactive menu which will allow 
you to jump directly to any of the other slides.

Create four slides:

When Slide 1 is loaded, select the Fill Color attribute of the slide editor.    Choose a green 
background for the slide. 

Advance the carousel to Slide 2.    Select a red background color for the slide.

Advance the carousel to Slide 3.    Select a white background color.

Advance the carousel to Slide 4.    Select a blue background color.

Move back to the first slide:

From the Carousel menu, choose Jump to Slide.

Double-click on Slide 1.

Change the exit options for Slide 1:

Choose the Exit attribute of the slide editor.

Deselect all exit options.    If a check appears by any of the last three options, remove the 
check by clicking on it.

Add a text element:

Click on Media, then Text to add a new text element and drag it to a point 1/4 of the way 
from the top of the screen.

Edit the text to read:    "Choose a color:"

Adjust the size of the bounding box to accommodate all of the text if necessary.

Choose the Alignment attribute and select Center.

Add three more text elements:

Click on Media, then Text 3 times to add 3 more text elements.

Position these elements under the first text element in one column.

Edit the text elements to read:    "Red", "White" and "Blue" respectively.

Take the following steps for each of the last 3 elements:



Choose the Background Mode attribute and select Opaque.

Choose the Background Color attribute and select White.

Choose the Alignment attribute and select Center.

Drag the element directly to the left until it is not visible.

Assign a move to the "Red" text element:

Click on the element list and select the "Red" text element when the list appears.

Click on the Action icon and select Move.

Click on the horizontal center icon (2nd from right) to center the text horizontally on the 
screen with this move.

Edit the time setting for this move to 1.    (To edit time, position the cursor over the time 
display on the action list.    Click the mouse when the cursor changes shape and enter the
correct time.) 

Click on the Action icon and select Pause.

Edit the time setting for this pause action to 1000.

Now the "Red" text element will pop on the screen, then a 1 second pause will occur before any other
action.

Assign a move to the "White" text element:

Click on the element list and select the "White" text element when the list appears.

Click on the Action icon and select Move.

Click on the horizontal center icon to center the text horizontally on the screen with this 
move.

Edit the time setting for this move to 1.    

Click on the Action icon and select Pause.

Edit the time setting for this pause action to 1000.

Assign a move to the "Blue" text element:

Click on the element list to bring it up and select the "Blue" text element.

Click on the Action icon and select Move.

Click on the horizontal center icon to center the text element with this move.

Edit the time setting for this move to 1.

Check the escape options, before running the carousel:

From the Carousel menu, select Play Options.

Check the setting for Exit Presentation Key and select Escape if it is not already selected.

Under Carousel Presentation Mode, select Replay Carousel When Last Slide Finished.

Click on OK to exit from the Play Options dialog box.



View the first slide:

From the View menu, select Play Single Slide.

Double-click on the small thumbnail sketch of slide 1 to view the actions assigned to this 
slide.

Assign hot spots:

Click on the "Red" text element to select it.

Click on the Hot Spot attribute and choose Jump to Slide.

When the dialog box appears, double-click on Slide 2.

Click on the "White" text element to select it.

Click on the Hot Spot attribute and choose Jump to Slide.

When the dialog box appears, double-click on Slide 3.

Click on the "Blue" text element to select it.

Click on the Hot Spot attribute and choose Jump to Slide.

When the dialog box appears, double-click on Slide 4.

Play the example:

From the View menu, deselect Play Single Slide.

Double-click on the small thumbnail sketch of slide 1 to view the carousel.

The first slide is displayed.    Since no exit conditions were defined, Slide 1 remains on screen until a 
hot spot selection is made.    When a selection is made, a jump or branch is immediately made to the 
slide assigned to the hot spot definition.    

For example if "White" is selected, Slide 3, the White slide, will be shown immediately.    Any slides 
which follow the selected slide, will then be shown in order, until Slide 1 reappears.

Press Escape to exit.

Another branching technique might be to return immediately to Slide 1 after each slide is shown.

Take the following steps on Slide 2 and Slide 3 to set up this branching structure:

Select the Exit option from the slide attribute list.

Click on Select Next Slide.

When the dialog box appears, double-click on Slide 1.    

View the carousel once again.

Double-click on the small thumbnail sketch of Slide 1 to view the carousel.

Press Escape to exit when you have finished testing the carousel.

This tutorial focused on branching techniques used to create an interactive carousel.    If you have 
taken the three tutorials provided with the help system, you have been introduced to most of the basic
techniques used in creating SST presentations.    If you would like to try more examples refer to the 
tutorial included the SST manual.






